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APPENDIX D: ANSWERS 

Lab 1.1 − Creating Copies 
Company: Fabrikam Inc. 

 
In this exercise, you create three modified reports:  
 

• A primary copy of the Trial Balance Detail report 
• A primary copy of the Blank Invoice Form 
• A secondary copy of the Blank Invoice Form  

 

Solution 
Creating Primary Copies 
 

1. After entering the Microsoft Dynamics™ GP system and selecting 
the lesson company and a lesson user, select Report Writer from the 
Customize option on the Tools menu. The Report Writer main menu 
appears.  

2. Click the Reports button to open the Report Writer window where 
all original and modified reports are listed. Highlight Trial Balance 
Detail in the Original Reports list. 

 Why is the Copy button dimmed? 

 The report uses a temporary table; therefore, you can only 
create a primary copy of the report. 

3. Click the Insert button to insert the report into the Modified Reports 
list. Highlight the Trial Balance Detail report in the Modified 
Reports list. 

 Why are the Duplicate and Print buttons dimmed? 

 The report uses a temporary table; therefore, you can only 
create a primary copy of the report. Duplicate copies are 
considered secondary copies. The Print button is dimmed 
because the temporary table has not been created; therefore the 
report cannot be accurately printed. 

 What happens if you try to insert another copy of the report? 

 An alert message appears informing you that the report already 
exists in the Modified Reports list (will not let you insert another 
copy). 



Microsoft Official Training Materials for Microsoft Dynamics ™ 
Your use of this content is subject to your current services agreement 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  

Report Writer in Microsoft Dynamics GP 9.0 

Page 348  

Creating Secondary Copies 
 

1. After entering the Microsoft Dynamics GP system and selecting the 
lesson company and a lesson user, select Report Writer from the 
Customize option on the Tools menu. The Report Writer main menu 
appears.  

2. Click the Reports button to open the Report Writer window where 
all original and modified reports are listed. Highlight the Blank 
Invoice Form in the Original Reports list. 

 Why are both the Insert and Copy buttons available? 

 The report does not use a temporary table; therefore, you can 
create either a primary or a secondary copy of the report. 

3. Click the Insert button to insert the report into the Modified Reports 
list. Highlight the Blank Invoice Form report in the Modified Reports 
list. Note that the Duplicate and Print buttons are available for use 
with this report. 

4. Click the Copy button to copy the Blank Invoice Form into the 
Modified Reports list. Name the report "Blank Invoice Form- copy" 
and click OK. 

 Why did you need to give the copy of the Blank Invoice Form a 
unique name? 

 All secondary copies must have a unique name because the name 
of the report is the application's method of differentiating them 
in the Custom Reports window. 

 Are you able to create additional copies of the report using the Copy 
button? 

 Yes. 

 Are you able to create additional copies of the report using the 
Duplicate button? 

 Yes. 
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Lab 1.2 − Granting Access and Printing Primary Copies 
Company: Fabrikam, Inc. 

 
Background Information: A user can print primary reports in Microsoft 
Dynamics GP or Report Writer unless the report uses a temporary table. If the 
report uses a temporary table, the report must be printed within Microsoft 
Dynamics GP to ensure the temporary table is created before the report is printed. 
Security access must be granted to the primary copy of the report to ensure that 
the original report will be replaced with the primary copy. In the first part of this 
section, you work with the Trial Balance Detail report, and then you look at the 
Blank Invoice Form.  
 
Scenario: Since you have decided to modify the Trial Balance Detail Report and 
the Blank Invoice Form, you need to grant access to the modified reports before 
printing them from Microsoft Dynamics GP. Grant access to the reports to your 
User ID and print the reports. To begin this exercise, open Report Writer. 

Solution 
Trial Balance Detail report 
Granting Access to the Primary Copy 
 

1. Select Microsoft Dynamics GP from the File menu to return to the 
Microsoft Dynamics GP application. (FILE→MICROSOFT DYNAMICS GP) 

2. To access the Security Setup window, select Tools and Setup from 
the Menu Bar. Select the Security menu option from the system 
setup menu. (TOOLS→SETUP→SYSTEM→SECURITY) 

3. In the Security Setup window, make the following selections: 

 
User Select the current User ID 
Company Select the lesson company 
Product Microsoft Dynamics GP 
Type Modified Reports 
Series Financial 

 
4. The Trial Balance Detail appears in the Access List. Double-click on 

this report to grant the current user access to the report. An asterisk 
appears beside the report name in the access list. 

5. Click OK to close the Security Setup window and save your 
selections. 
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Printing the Primary Copy in Microsoft Dynamics GP 
 

1. Now that you have indicated to Microsoft Dynamics GP that you 
want to replace the original copy of the report with the primary copy, 
you can print the report.  

2. To print the report, select Reports and Financial. From the Financial 
Reports menu, select Trial Balance. (REPORTS→FINANCIAL→TRIAL 
BALANCE) 

3. In the Trial Balance Report window, click the New button to create a 
new option to use when printing this report. 

4. Make the following selections in the Trial Balance Report Options 
window: 

 
Option Option1 
Include Posting Accounts 
Sort by Account 
Subtotal by No Subtotals 
Year Open and 2007 
Print Currency In Functional 
Ranges Date 
From Enter Date and 01/01/07 
To Enter Date and 01/31/07 

 
5. Click the Insert button to insert the date restriction into the 

Restrictions list.  

6. Click the Destination button. 

7. Select the Screen check box in the Destination box. Make sure the 
Printer check box is not selected.  

8. Click OK to close the Report Destination window and save your 
selections. 

9. Click the Save button to save your new option.  

10. Close the Trial Balance Report Options window. 

11. In the Trial Balance Report window, select Option 1 from the 
Options list and insert it into the Print List.  

12. Click the Print button to print the report to the screen.  

13. After the report has finished printing, close the Screen Output and 
Trial Balance Report windows. 
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Blank Invoice Form 
Granting Access to the Primary Copy 
 

1. To access the Security Setup window, select Tools and Setup then 
System. Select the Security option from the menu. 
(TOOLS→SETUP→SYSTEM→SECURITY) 

2. In the Security Setup window, make the following selections: 

 
User Select the current User ID 
Company Select the lesson company 
Product Microsoft Dynamics GP 
Type Modified Reports 
Series Sales 

 
3. The Blank Invoice Form should appear in the Access List. Double-

click on this report to grant the current user access to the report. An 
asterisk should appear beside the report name in the access list. 

4. Click OK to close the Security Setup window and save your 
selections. 

Printing the Primary Copy in Microsoft Dynamics GP 
 

1. Now that you have indicated to Microsoft Dynamics GP that you 
want to replace the original copy of the report with the primary copy, 
you can print the report. To do this, select Transactions and Sales. 
Select Invoice Entry from the menu. 
(TRANSACTIONS→SALES→INVOICE ENTRY) 

2. Click on the previous record browse button in the Invoice Entry 
window. If you have not made any previous entries in the Invoicing 
module, the document displayed is IVC23. 

3. Select Extras and Options and then Document Format from the 
menu to open the Invoice Document Formats window.  

4. Verify that the Invoice Format is Blank Paper. Click OK to close the 
window. 

5. Click the Print button. In the Report Destination window, select the 
Screen check box. Click OK to close the Report Destination window 
and print the report. 

6. After viewing the report, close the windows. 

 Using the Screen Output window, how can you determine the Report 
Writer name for a Microsoft Dynamics GP report? 

 The report toolbar contains the title of the report in Report 
Writer. 
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Lab 1.3 − Secondary Copies 
Company: Fabrikam, Inc. 

 
Background Information: A user can print secondary reports in Microsoft 
Dynamics GP or Report Writer. The user does not need to grant access to a 
secondary copy of a report because the original report is not being replaced; the 
secondary copy is printed from a different location within Microsoft Dynamics 
GP.  
 
Scenario: The modified Blank Invoice Form is being used by Operations for 
invoicing. The Sales and Marketing department would like to use this invoice 
format also, but they need to make a few minor changes. Since Sales and 
Marketing only issue occasional invoices, you have decided to use the secondary 
copy of the Blank Invoice form that has previously been created. (Blank Invoice 
Form − copy) 

Solution 
Verifying Access to the Secondary Copy 
 

1. To access the Security Setup window, select Tools and Setup then 
System from the menu bar. Select the Security option from the 
System Setup menu. (TOOLS→SETUP→SYSTEM→SECURITY) 

2. In the Security Setup window, make the following selections: 

 
User Select the current User ID 
Company Select the lesson company 
Product: Microsoft Dynamics GP 
Type Custom Reports 
Series Sales 

 
3. Note that you already have access to the Blank Invoice Form – copy.  

4. Click OK to close the Security Setup window. 

Printing the Secondary Copy in Microsoft Dynamics GP 
 

1. Select Customized from the Reports menu. (REPORTS→CUSTOMIZED) 

2. Make the following selections in the Custom Reports window: 

 
Product Microsoft Dynamics GP 
Series Sales 
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3. Highlight Blank Invoice Form − copy in the Custom Reports list and 
insert it into the Print List. 

4 Highlight Blank Invoice Form − copy in the Print List and click the 
Destination button. Verify that only the Screen check box is 
selected and then click OK to close the Report Destination window. 
Click the Print button to print the report to the screen.  

Test Your Knowledge − Report Writer Window Components 
Record the name of each of the numbered options and an explanation of what the 
button or field does in Report Writer. 
 

 
 

1. Insert button − Use to create a primary copy of an original report. 

2. Copy button − Use to create a secondary copy of an original report. 

3. New button − Use to create a custom report. 

4. Open button − Opens the Report Definition window. 

5. Delete button − Deletes a report from the Modified Reports list. 

6. Duplicate button − Creates a copy of a report in the Modified 
Reports list. 

7. Import button − Use to import reports from another Reports 
dictionary into the current Reports dictionary. 

8. Original Reports list − Lists the reports stored in the dynamics.dic 
file. 

9. Modified Reports list − Lists the reports stored in the reports.dic file. 
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Test Your Knowledge − Report Writer Overview 
 

1. What type of report requires you to grant access to the report before 
you are able to print it? Why is this required? 

 Primary copies of a report require you to grant access to the 
report before you are able to print it. They replace the original 
report. 

2. Why are you not able to print a report that uses a temporary table in 
Report Writer? 

 The code that generates the temporary table runs behind the 
Report Options window for the original report, and you do not 
have access to this window in Report Writer. 

3. Why are you not able to create a secondary copy of a report that uses 
a temporary table? 

 The report uses a temporary table, which means you can only 
create a primary copy. This is because the temporary table is 
created by code that runs behind the Report Options window for 
the original report, and you do not use the original report's 
Report Options window when you print a secondary copy. 

4. For which types of reports are you not allowed to create report 
options in Microsoft Dynamics GP? 

 Secondary copies and custom reports are the types of reports. 
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Lab 2.1 − Sorting 
Company: Fabrikam, Inc. 

 
Scenario: Your company has decided that the Shipping Methods Report would 
be more useful if it were sorted by company name. As a result, you have been 
requested to make the change. 

Solution 
 

1. Select Report Writer from the Customize option on the Tools menu. 
The Report Writer main menu appears. 
(TOOLS→CUSTOMIZE→REPORT WRITER) 

2. Click the Reports button to open the Report Writer window where 
all original and modified reports are listed. 

3. From the Original Reports list, highlight the Shipping Methods 
Report and select Copy. A window appears. Name the report 
Shipping Methods-by supplier and click OK.  

4. Highlight the report in the Modified Reports list, and click the Open 
button to open the Report Definition window. 

5. Select Sort; the Sorting Definition window opens. 

6. Highlight Shipping Method in the Table fields list and click Insert.  

7. Highlight Carrier in the Table fields list and click Insert, and then 
click OK to close the Sorting Definition window. 

 The sorting method you create prints the information on the report in 
order of carrier. If a carrier provides more than one shipping method, 
then the methods it provides appears in alphabetical order. When 
finished the Sorting Definition window should look like this: 

 

 
 

 Note that the first field you insert actually becomes the second field 
that the report is sorted by. 
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8. Highlight each field in the Sort By list, and select Ignore Case. 
Leave the Descending selection clear.  

9. Click OK to close the window and save the sorting method. 

10. Click OK in the Report Definition window.  

11. In the Report Writer window, highlight the report in the Modified 
Reports list and click Print.  

12. Select the Screen option in the Report Definition window that 
appears and click OK.  

 The report appears in the Screen Output window similar to the 
following illustration. Notice the report is now printed in order of 
carrier, and if the records have the same carrier, they are sorted by 
shipping method. 
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Lab 2.2 − Restricting 
Company: Fabrikam, Inc. 

 
Scenario: The Accounts Payable department would like a list of all the Shipping 
Methods they should be using when adding new Vendors or Vendor Classes. 
Make a copy of the Shipping Methods Report, and place a restriction on it to 
print only shipping methods that have shipping types set to pickup. 

Solution 
 

1. Select Report Writer from the Customize option on the Tools menu. 
The Report Writer main menu appears. 
(TOOLS→CUSTOMIZE→REPORT WRITER) 

2. Click the Reports button to open the Report Writer window where 
all original and modified reports are listed. 

3. From the Original Reports list, highlight the Shipping Methods 
Report and select Copy. A window opens, prompting you to name 
the new report. Enter Shipping Methods-Pickup Carriers as the 
name.  

4. Highlight the report in the Modified Reports list and select Open. 

5. Next, create a restriction expression. The restriction you create 
requires the shipping type to be Pickup to include it on the report. 
Once you have written the expression, the window should look like 
the following illustration. 

 

 
 

6. Select Restrictions to open the Report Restrictions window, and then 
select New to open the Report Restriction Definition window. 
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7. Make the following entries: 

 
Restriction Name Shipping Restriction 
Report Table Shipping Methods Master 
Table Fields Shipping Type 

 
 Click the Add Field button. 

 
Operators = 
Type Integer 
Constant 0 

 
 Click the Add Constant button. 

 * The Shipping Type field has two possible values, pickup or 
delivery. The field is stored as an integer in Microsoft Dynamics GP 
and Pickup=0, Delivery=1.  

8. Select OK to close the window and save the restriction, then close 
the Report Restrictions window.  

9. Select OK in the Report Definition window. 

10. In the Report Writer window, highlight the report in the Modified 
Reports list and select Print. Select the Screen option in the Report 
Destination window and click OK.  

 The report appears in the Screen Output window as shown in the 
following illustration. Only records that have shipping types set to 
pickup should appear on the report. 

 

 
 

 Only records that have shipping types set to pickup should appear on 
the report. 
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Lab 2.3 − Secondary Copy − Restrictions 
Company: Fabrikam, Inc. 

 
Scenario: The Payroll department has requested a list of the typical expense 
accounts that will be used for posting payroll expenses (accounts between 5000 
and 6000) for any given department. You have decided to use the Administration 
department as an example. Include any other departments that begin with a "1" 
also. Since the restrictions for this report will not need to be changed on an 
ongoing basis, create the modified report as a secondary copy of the Accounts 
report. 
 

HINT: When working with the Microsoft Dynamics GP Account Number field in the 
Report Writer, note that the account number is actually stored as a string (composite) 
field even though it typically displays numeric characters.  

 

Solution 
Creating the Report 
 

1. Select Report Writer from the Customize option on the Tools menu. 
The Report Writer main menu appears. 
(TOOLS→CUSTOMIZE→REPORT WRITER) 

2. Click the Reports button to open the Report Writer window where 
all original and modified reports are listed. 

3. From the Original Reports list, highlight the Accounts report and 
select Copy. Name the report "Accounts- restrictions exercise." 

4. Highlight the "Accounts- restrictions exercise" report in the Modified 
Reports list, and click the Open button to open the Report Definition 
window. 

Creating the First Restriction 
 

1. Click the Restrictions button to open the Report Restrictions 
window. Click the New button to open the Report Restriction 
Definition window. Make the following selections in the Report 
Restriction Definition window: 

 
Restriction Name Department Starts with a 1 
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Restriction Expression: Fields 

 
Report Table: Account Master 
Table Fields Account Number: 

Account_Segment_Pool1 
 

 Click the Add Field button. 

 
Operators = 
Functions WILDCARD 

 
Constants 

 
Type String 
Constant 1* 

 
 Click the Add Constant button. 

 The resulting restriction expression should be: 

 GL_Account_MSTR.Account Number:Account_Segment_Pool1 = 
WILDCARD("1*") 

 
 What is the purpose of this first restriction? 

 The first restriction limits the report to accounts from 
department 100 to department 199. 

 
2. Give a brief explanation of the syntax used in the restriction 

expression: 

 GL_Account_MSTR Account Number:Account_Segment_Pool1: 

 = WILDCARD(1*): 

 
3. Explain how the WILDCARD function is used. 

 The Wildcard function is used by selecting it from the Function 
drop-down list. 

 
4. Click OK to save the restriction and close the window. Verify that 

the new restriction has been saved. 
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Creating the Second Restriction 
 

1. Click the New button to open the Report Restriction Definition 
window. Make the following selections in the Report Restriction 
Definition window: 

 
Restriction Name Accounts 5000 through 6000 

 
Restriction Expression: Fields 

 
Report Table: Account Master 
Table Fields Account Number: 

Account_Segment_Pool2 
 

 Click the Add Field button. 

 
Operators >= 

 
Constants 

 
Type String 
Constant 5000 

 
 Click the Add Constant button. 

 
Operators AND 

 
Fields 

 
Report Table Account Master 
Table Fields Account Number: Account_Segment_Pool2 

 
 Click the Add Field button. 

 
Operators <= 

 
Constants 

 
Type String 
Constant  
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 Click the Add Constant button. 

 The resulting restriction expression should be: 

 GL_Account_MSTR.Account Number:Account_Segment_Pool2 
>= "5000" AND  

 GL_Account_MSTR.Account Number:Account_Segment_Pool2 
<= "6000" 

 What is the purpose of this second restriction? 

 Restricts the account number segment from 5000 to 6000. 

2. Give a brief explanation of the syntax used in the restriction 
expression: 

 GL_Account_MSTR Account Number:Account_Segment_Pool2: 

 >= 5000: 

 AND: 

 GL_Account_MSTR Account Number:Account_Segment_Pool2: 

 <= 6000: 

3. Click OK to save the restriction, and close the window.  

4. Verify that the new restriction has been saved, and click OK to close 
the Report Restrictions window. 

Printing the Report in the Report Writer 
In the Report Writer window, click the Print button. Select to print the report to 
the screen. After viewing the report, close the Screen Output window. 

Printing the Report in Microsoft Dynamics GP 
Do you need to grant access to this report before you can print it in Microsoft 
Dynamics GP? Why or why not? 
 
No, because it is a secondary copy (you automatically have access to 
secondary copies of reports in Microsoft Dynamics GP). 
 

1. Switch into the Microsoft Dynamics GP application. 
(FILE→MICROSOFT DYNAMICS GP) 

2. Select Reports from the toolbar and select Customized. 
(REPORTS→CUSTOMIZED) 

3. Select Microsoft Dynamics GP as the Product in the Custom Reports 
window. The Financial series will default into the Series field.  

4. Highlight the Accounts- restrictions exercise report and insert it into 
the Print List.  
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5. Highlight the report in the Print List and click the Destination button 
to open the Report Destination window. Select the Screen check box 
and make sure the Printer check box is not selected.  

6. Click OK to close the Report Destination window and save your 
selections. 

7. In the Custom Reports window, click the Print button to print the 
report to the screen. The report appears similar to what is shown in 
the following illustration: 
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Test Your Knowledge − Report Definition 
Solution 
Answer the following questions about the Report Definition window using the 
information provided in this chapter. 
 

 
 

1. The Series indicates the Series to select when granting security 
access to a report in Microsoft Dynamics GP. What else is this 
option used for? 

 This option is also used to indicate the series in which the main 
table of the report is categorized. 

 
2. What should you take into consideration when selecting the main 

table for a report? 

 Select the table that you will link other tables to in a way that 
enables data in the report to be printed accurately, the table that 
contains a key by which you could sort the report without having 
to create a user-defined sorting option, the table that contains the 
most information, or the table that contains the most general 
information. 

 
3. What is the function of the Using Key field? 

 This field determines how the report is sorted in the absence of a 
user-defined sorting option. 
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4. How can you find out what fields make up a particular key? 

 You can use either the Tables drop-down list in Report Writer or 
the Table Descriptions window available in both Report Writer 
and Microsoft Dynamics GP. 

 
5. Look up the General Ledger Trial Balance Temporary table using 

Table Descriptions. How many keys are associated with this table? 
What fields make up each key? 

 One key is associated with this table. The Account Number field 
makes up each key. 

 
6. Can you change the Using Key field for a primary copy of a report? 

 Yes. 

 
7. Can you change the Using Key field for a secondary copy of a 

report? 

 Yes. 

 
8. What does Max Records set to 0 indicate? 

 It indicates that all records in the report are printed (unless a 
user-defined restriction is created, in which case only records 
that adhere to that restriction will be printed). 

 
9. What type of report are you working with if the Text Report check 

box is clear? 

 You are working with a graphics report. 

 
10. What is the function of the Skip Blank Records check box? 

 This allows you to prevent records from being printed if a field 
in the record, or one that is related to the record, is blank. 

 
11. What is the function of the Suppress Decimals check box? 

 This allows you to prevent the decimal and decimal digits from 
printing on the report for all of the currency fields. 

 
12. What is the function of the Best Text Fit option button? 

 This tells Report Writer to determine if the report is printed 
using compressed or uncompressed text (Report Writer selects 
the one that allows all of the information to be printed on the 
report). 
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13. What is the function of the Variable Characters/Inch option 
button? 

 This allows you to use more than one font on a text report; it 
supports a different font size on each line of the report. 

 
14. What is the function of the Six Lines/Inch check box? 

 This indicates that six lines of the report should be printed in 
each inch of a text report. It increases the height of condensed 
text, but not the width, to ensure that six lines are printed in 
every inch of the report. 

 
15. What is the function of the Preprinted Form check box? 

 This releases Report Writer's built-in margins to allow you to 
print fields as close to the edge of the form as your printer 
allows. 

 

Lab 3.1 − Adding Fields 
Company: Fabrikam, Inc. 

 
Scenario: Your company wants to start printing its slogans on various reports 
throughout the system. There are two User Defined fields available for each 
company, and you decide to use these fields to store the company slogans. At this 
point in time, you have not decided which reports these slogans should appear 
on. To view the new fields, modify the Company Settings Report. You need to 
set access to the primary copy to print the modified report from the Microsoft 
Dynamics GP system.  

Solution 
 

1. Open the Company Setup window in Microsoft Dynamics GP. 
(TOOLS→SETUP→COMPANY→COMPANY) 

2. Enter a company slogan into the User Defined 1 and User Defined 2 
fields. Click OK to save the new slogans. 

3. Select Report Writer from the Customize option on the Tools menu. 
(TOOLS→CUSTOMIZE→REPORT WRITER) The Report Writer main menu 
appears.  

4. Click the Reports button to open the Report Writer window where 
all original and modified reports are listed. 

5. Highlight the Company Settings Report in the Original Reports list 
and click Insert. 
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6. Highlight the report in the Modified Reports list and select Open to 
open the report.  

7. In the Report Definition window that appears, enter the following 
information in the appropriate fields. Leave all other fields as they 
default. 

 
Using Key SY_Company_MSTR_Key2 
Maximum Records 0 
Format Options Mark: Text Report 

Mark: Skip Blank Records 
Text Report Options Best Text Fit 

 
8. Click the Layout button to open the Report Layout window. The 

modifications you make to the report should resemble the illustration 
below when it is complete. Complete these steps: 

– Select the labels for the User Defined 1 and User Defined 2 
fields and delete them.  

– Use the text tool to add new labels that describe the actual 
information that was entered into those fields during company 
setup. For this exercise, enter Slogan-1 and Slogan-2. 

– In the body of the report, remove all of the text prompts and 
fields on the right-hand side of the layout. Remove all fields 
below the Slogan fields in the layout. 
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9. Save the modifications to this report by closing the layout window 
and selecting to save changes when the dialog box appears. 

10. Click OK in the Report Definition window. 

11. Set access to the report in Fabrikam, Inc. for your User ID. To do 
this, select Microsoft Business Solutions-Microsoft Dynamics GP 
from the File menu. (FILE→MICROSOFT DYNAMICS GP) 

12. When the main menu of the Microsoft Dynamics GP system appears, 
select Tools and Setup from the menu bar, and then select System 
and Security. (TOOLS→SETUP→SYSTEM→SECURITY) 

13. In the Security Setup window, make the following selections. 

 
User ID Select your User ID 
Company Fabrikam, Inc. 
Product Microsoft Dynamics GP 
Type Reports 
Series Company 

 
 A list of all Microsoft Dynamics GP reports appears. Check to be 

sure that your User ID has access to the original Company Settings 
report.  

14. If there is not an asterisk (*) by the name of the report, double-click 
it to grant access to the report for your User ID. 

15. Change the Type to Modified Reports, and then select Company 
again as the Series.  

16. Double-click the Company Settings Report to give your User ID 
access to the modified report.  

17. Click OK to save the changes you have made and close the window. 

18. Print the report from Microsoft Dynamics GP using the same 
window used to print the original version. 
(REPORTS→COMPANY→SETUP) 

17. Create a new report option for this report. Verify that the new 
slogans you entered are being printed on the report. 
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Lab 3.2 − Convert Text Report to Graphic 
Company: Fabrikam, Inc. 

 
Scenario: Depending on the audience for a report, it may be advantageous to 
change the quality of appearance. You have recently learned that the Company 
Settings Report is going to be distributed at an important meeting, and, therefore, 
you decide to make a few changes. 

Solution 
 

1. Select Report Writer from the Customize option on the Tools menu. 
(TOOLS→CUSTOMIZE→REPORT WRITER) 

2. The Report Writer main menu appears. Click the Reports button to 
open the Report Writer window where all original and modified 
reports are listed. 

3. Delete the existing primary copy of the Company Settings Report 
from the Modified reports list by highlighting it and clicking the 
Delete button. 

4. Create a new primary copy. The report appears in the Modified 
Reports list. Highlight it and select Open to open the Report 
Definition window. 

5. Make the following selections in the Report Definition window. 

 
Maximum Records 0 
Format Options Unmark Text Report 

 
6. Click the Layout button to open the Report Layout window.  

7. Remove all fields and labels in the H1 area of the report except the 
Company Name, Location ID, Location Name, Address, City, 
State, and Zip Code fields.  

8. Reposition the fields and labels to close up the space left by the 
Address Contact field. 

9. Move the Zip Code field and label to its own line. 

10. Select all of the items in the report layout. 

11. Select Drawing Options from the Tools menu. (TOOLS→DRAWING 
OPTIONS) 

12. Change the font for the fields to Times 10. 

13. Click OK and close the window.  
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14. Select the text for the title of the report in both the report header and 
page header sections and make it Bold. Both fields can be selected at 
once by clicking on the first field and then holding down the shift 
key while clicking on the second field. When complete, the window 
should appear like the following: 

 

 
 

15. Close the window, and save changes when the dialog box appears.  

16. Click OK in the Report Definition window. 

17. Switch to Microsoft Dynamics GP by selecting it from the File 
menu.  

18. Print the report by selecting REPORTS→COMPANY→SETUP and 
inserting the demo option for the Company Settings report.  

 The report should look similar to the following: 
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19. Click the Modify button on the toolbar of the Screen Output window 
to return to the Layout window in Report Writer.  

20. Remove the Address 3 field from the Layout, since you plan to only 
use a maximum of two address lines for your companies. This will 
reduce the empty space on your report. 

21. Save the changes to the report.  

22. Print the report again by switching back to Microsoft Dynamics GP 
(FILE→MICROSOFT DYNAMICS GP) and selecting REPORTS→COMPANY 
and inserting the demo option for the Company Settings report.  

23. Notice the change to your report. There should be only one line of 
empty space between the Address fields and the City field. This 
blank line exists because you have no address listed on the second 
line for the sample company. 

 
NOTE: If you added a second address line to the sample company address, this line 
would print on the report instead of a blank line. You can also use calculated fields to 
remove the blank line if some companies use a second line address and others do not. If 
all companies only use one address line, simply remove the Address 2 field from the 
report layout. 
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Lab 3.3 – Adding Fields, Text, and Graphics 
Company: Fabrikam, Inc. 

 
Background Information: The goals of this exercise are to practice working in 
the Report Layout window, learn how the Drawing Options window can be used 
to customize a report, learn how to paste a picture into your Picture Library, learn 
how to place a graphic into your report layout, and practice using the divider tool. 
 
Scenario: The annual company conference is fast approaching and since the 
company logo has changed, you need to print new name tags for every employee. 
The name tags include the name of the employee, the position held by the 
employee, the department in which the employee works, the starting date of the 
employee, and the company logo. 

Solution 
Creating the New Report 
 

1. Launch Report Writer. (TOOLS→CUSTOMIZE→REPORT WRITER) 

2. Click the Reports button from the Toolbar. 

3. Create a new report by clicking the New button. Make the following 
selections in the Report Definition window: 

 
Report Name Employee Name Tags 
Series Payroll 
Main Table Payroll Master 
Using Key Key 1 
Max Records 0 
Format Options None 
Page Orientation Portrait 
Printing Options None 

 
4. Click the Layout button to open the Report Layout window.  

5. You only need one section in this report: the Body. Therefore, you 
need to remove the PH, RH, and RF sections from the layout. To do 
so, select Report Section Options from the Tools menu to open the 
Report Section Options window.  

– Clear the check boxes next to the following sections: Page 
Header, Report Header, and Report Footer. The only section that 
should be selected is the Body section. 

– Click OK to close the Report Section Options window and 
return to the layout. Note that the only section remaining in the 
Report Layout window is the B section. 
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6. Increase the size of the body. Do this by clicking on the B in the 
vertical gray bar on the left side of the Report Layout window and 
dragging it down, noting the size of the section in the lower portion 
of the Toolbox window. 

Adding Fields and Text to the Report Layout Window 
 

7. From the Toolbox, click and drag the following fields into the Body 
of the report: 

– First Name 
– Last Name 
– Job Title 
– Department 
– Start Date 

 
8. Use the Text tool from the Toolbox to add the following text 

prompts to the report: 

– Position: 
– Department: 
– Member Since: 

 
9. Using the Report Drawing Options window, change the font 

assigned to the First Name and Last Name fields to Times 18. 
Change the font assigned to the remainder of the fields and all of the 
text prompts to Helvetica 10.  
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Adding a Graphic to the Picture Library 
 

10. This step in creating your report is going to take place outside of 
Report Writer and the Microsoft Dynamics GP system. You need to 
use a drawing application, such as Microsoft® Paint, to create a logo 
for your company. Copy the logo to the clipboard and paste it into 
the Picture Library within Report Writer. Once the company logo 
graphic is in the Picture Library, use it on any graphics report.  

11. Open the Paint application (or another drawing application). Create a 
company logo. After you have created the logo, copy it to the 
clipboard. 

12. Switch back to Report Writer. Select Pictures from the Resources 
menu to open the Pictures window. Click the New button to open the 
Picture Definition window. Enter "Company Logo" in the Picture 
Name field. Then click inside the Picture frame.  

13. Note that the frame now consists of two lines rather than one. Select 
Paste from the Edit menu to paste your graphic into the picture 
frame. Click OK to close the Picture Definition window. Verify that 
your picture is listed in the Pictures window, and then close the 
window to return to the Report Layout window. 

Placing a Graphic in the Report Layout Window  
 

14. To place a graphic in your report layout, click the Picture tool on the 
Layout tab in the Toolbox window. Move your mouse back to the 
layout, and click in the approximate area where you want the 
graphic. You can resize and move it later, so it is not necessary to be 
exact in the initial placement.  

 When the Pictures window opens, select Company Logo from the 
list, and click OK to close the window. The graphic is placed in the 
layout. Use the handles to resize the graphic. Move the graphic into 
the body of the report to the left of the text prompts and fields.   



Microsoft Official Training Materials for Microsoft Dynamics ™ 
Your use of this content is subject to your current services agreement 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  

Appendix D: Answers 

Page 375 

Creating Columns  
 

15. Use the Divider tool from the Toolbox to create two columns for the 
report. To create columns, click the Divider tool on the Layout tab in 
the Toolbox window. Move your mouse back to the layout, and click 
in the approximate area where you want the division.  

 

 
 

16. Close the Report Layout window, making sure to save your changes.  

17. Click OK to close the Report Definition window. 

Printing the Report  
 

18. In the Report Writer window, click the Print button. Select to send 
the output to the screen. The output should appear like the following: 
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Test Your Knowledge − Report Layout 
 

1. Can you use the Report Drawing Options window to change fonts for 
text prompts, fields, or both? 

 Both 

 
2. What is the storage size limitation for graphics in Report Writer? 

 32K (or 32,000 bytes) 

 
3. In which report sections are you allowed to use the Divider tool? 

 The Body 

 
4. When using the Divider tool, will text be printed from left to right 

and then from top to bottom or from top to bottom and then left to 
right? 

 Left to right and then top to bottom 
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Lab 4.1 − Linking Tables 
Company: Fabrikam, Inc. 

 
Scenario: In this lab, link all of the tables needed to create an Invoicing report. 
Create an Invoice Form report that contains information from all of the pertinent 
Invoicing tables. 

Solution 
 

1. Launch Report Writer by selecting Report Writer from the 
Customize option on the Tools menu. The Report Writer main menu 
appears. (TOOLS→CUSTOMIZE→REPORT WRITER) 

2. Click the Reports button to open the Report Writer window where 
all original and modified reports are listed. 

3. Click New and the Report Definition window opens. Enter New 
Invoice Form as the Report Name. 

4. Select Sales for the Series.  

5. From the Main Table list select Invoicing Transaction Work. 

6. In the Using Key list select IVC_HDR_WORK_Key1.  

7. Accept the defaults for the Format and Printing Options. Then select 
Tables to link additional Invoicing tables to the report.  

8. On the Report Table Relationships window, highlight the Invoicing 
Transaction Work table from the list of Report Table Relations and 
select New.  

9. Select RM Customer MSTR and click OK. 

10. Repeat the previous two steps for each of the following tables:  

– Customer Master Address File  
– Invoicing Document Setup  
– Invoicing Transactions Amounts Work  

 
 Each of these tables is linked from the Invoicing Transaction Work 

table. 

11. On the Report Table Relationships window, highlight the Invoicing 
Transactions Amounts Work table from the list of Report Table 
Relations and select New. A different list of tables will be available.  

12. Select Item Master and click OK. 
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13. Repeat the previous two steps for the Invoicing Line Comments and 
the Invoicing Serial and Lot Number Work tables. Each is linked 
from the Invoicing Transactions Amounts Work table. 

 When you have finished linking the tables, the Report Table 
Relationships window should look like the following illustration. 

 

 
 

14. Select Close in the Report Table Relationships window to save the 
link and close the window. 

 At this point, all of the pertinent information is available to create an 
Invoicing Form report. 
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Lab 4.2 − Additional Headers and Footers 
Company: Fabrikam, Inc. 

 
Scenario: The president of your company has asked for a User Companies 
Report that lists each user and the companies to which they have access. In 
addition, the president would like information regarding the total number of 
companies each user has access to. Add the necessary report sections and a field 
that counts the number of companies each user has access to. 

Solution 
 

1. Select Report Writer from the Customize option on the Tools menu. 
The Report Writer main menu appears.  

2. Click the Reports button to open the Report Writer window where 
all original and modified reports are listed. 

3. Click the New button to open the Report Definition window. Make 
the following entries. 

 
Report Name User Companies: Additional Sections 
Series System 
Main Table User-Company Access 
Using Key SY_User_Company_Access_REL_Key1
Printing Options First Page Header, Last Page Footer 

 
4. To access all the fields you use on the report, add one more table to 

the report. To do this, select the Tables button to open the Report 
Table Relationships window.  

5. Select New and highlight the Company Master table in the list. Click 
OK, and then Close on the Report Table Relationships window. 

6. From the Report Definition window, select Layout to open the 
Report Layout window.  

7. Create an additional header and footer. This can be done by selecting 
Report Section Options from the Tools menu and by clicking the 
New button located next to the Additional Headers list. Make the 
following entries to create the additional header, and then select OK. 

 
Header User ID 
Name 0 
Records Per Report Body  
Print when field changes User-Company Access 
 User ID 
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8. On the Report Section Options window, click the New button located 
next to the Additional Footers list. Make the following entries, and 
then click OK to close the Footer Options window. 

 
Footer User ID 
Name 0 
Records Per Report Body  
Print when field changes User-Company Access  
 User ID 

 
9. Click OK to close the window. The additional header and additional 

footer labeled H1 and F1 are now part of the report layout. 

10. Begin creating the layout of the report by selecting the User-
Company Access Table from the drop-down list within the Toolbox 
window. Highlight the User ID field, and drag it into the additional 
header section of the report. Position it near the left of the report.  

11. Select the Company Master table from the drop-down list within the 
Toolbox window. Highlight the Company Name field, and drag it to 
the body of the report. Position it to the right of the User ID field. 

12. Create a field that counts the number of companies each user has 
access to. Highlight the Company Name field in the Toolbox and 
drag it to the additional footer. Place it below the first Company 
Name field in the body of the report.  

13. From the Tools menu, select Report Field Options, or double-click 
on the field in the report layout. From the Report Field Options 
window, set the Field Type to Count. Click OK to save changes and 
close the window. Resize the field to an appropriate size. 

14. Use the text tool to make a title for the report and labels for the three 
fields added to the report layout. Position the report title in the report 
header and the labels to the left of the appropriate field.  

 
Report User Access 
Title User ID 
User ID Field Companies 
Company Name Field User-Company Access  
Count Field Total companies for this user 

 
15. Use the Drawing Options window (TOOLS→DRAWING OPTIONS) to 

change the font to Helvetica 24 point for the RH section of the report 
and Helvetica 12 point - bold and italic for the rest of the report. 
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16. Resize the report sections so they are similar to the illustration shown 
below. Do this by clicking on the section name in the vertical gray 
bar on the left side of the Report Layout window and then dragging it 
down, noting the size of the section in the lower portion of the 
Toolbox window. 

17. Close the Report Layout window selecting to save the changes made, 
and then click OK to close the Report Definition window. 

 The layout should resemble the following illustration: 

 

 
 

18. Print the report to the screen using Report Writer. The screen output 
should look similar to the following: 
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Lab 4.3 − Additional Headers and Footers 
Company: Fabrikam, Inc. 

 
Scenario: Fabrikam, Inc. relies heavily on the organization of vendors by vendor 
class. Because of this, modify the Vendor Summary Report so that the vendor 
information is sorted and grouped according to each vendor class. Create the 
modified report as a secondary copy, and name it Vendor Summary by Class. 

Solution 
 

1. Launch Report Writer. (TOOLS→CUSTOMIZE→REPORT WRITER) 

2. Click the Reports button to open the Report Writer window where 
all original and modified reports are listed. 

3. Highlight the Vendor Summary report in the list of Original Reports, 
and click Copy to make a secondary copy of the report. Enter 
Vendor Summary by Class as the new report name and click OK. 

4. Select the report from the list of Modified Reports and select Open. 

5. Create a sorting method for the report so the information on the 
report will print in order of vendor class. If the vendor class is the 
same for multiple vendors, the vendor information will then print in 
alphabetical order. To create this additional sorting method, use the 
Sorting Definition window, and insert the following sort by fields: 

 
1st Field  
2nd Field Vendor Class ID of table PM Vendor 

Master File  
 
HINT: Highlight Vendor Class ID in the Sort by field before inserting the Vendor ID. 
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6. After the sort by fields have been inserted, click OK to save the new 
sorting method. 

7. On the Report Definition window, select Layout to open the Report 
Layout window. 

8. Create an additional header and footer using the new sorting option 
you added to the report. This can be done by selecting Report 
Section Options from the Tools menu (TOOLS→SECTION OPTIONS) 
and by clicking the New button located next to the Additional 
Headers list. Make sure there is nothing highlighted in the list before 
clicking the New button.  

9. On the Header Options window, make these entries and then click 
OK to close the window: 

 
Header Name Vendor Class ID 
Records Per Report Body 0 
Print when field changes:  
  Report Table  PM Vendor Master File 
  Field Vendor Class ID 

 
10. To create the additional footer, click the New Button located next to 

the Additional Footers list. Make the following entries, and then 
click OK to close the window: 

 
Footer Name Vendor Class ID 
Records Per Report Body 0 
Print when field changes:  
  Report Table  PM Vendor Master File 
  Field Vendor Class ID 
Footer Options Page Break 

 
11. Click OK to close the Report Section Options window. The 

additional header and additional footer labeled H1 and F1 are now 
part of the report layout. 

12. Modify the layout of the report by adding the Vendor Class ID field 
to the H1 section of the report. Click and drag the Vendor Class ID 
field from the Toolbox onto the H1 section of the Report Layout.  
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13. Also using the text tool, insert a text prompt in the additional header 
section of the report along with a dotted line.  

 When complete the layout should resemble the following illustration: 

 

 

 
14. Close the Report Layout window, save the changes, and then click 

OK to close the Report Definition window. 

15. Print the report to the screen using the Report Writer. The screen 
should look similar to the illustration. Notice that each different 
Vendor Class ID appears at the top of a new page of the report. 

 
NOTE: Vendors not assigned to a class print first on your report. 
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Lab 5.1 − Array Fields 
Company: Fabrikam, Inc. 

 
Scenario: You have been asked to create a report to give an overview of your 
Customers aging. The Aging Period Amounts field is stored in an array. This 
exercise guides you through the creation of a simple report that includes adding 
the Aging Period Amount field to the report for all seven aging periods. 

Solution 
 

1. Select Report Writer from the Customize option on the Tools menu. 
The Report Writer main menu appears. (TOOLS→CUSTOMIZE→ 
REPORT WRITER) 

2. Click the Reports button to open the Report Writer window where 
all original and modified reports are listed. 

3. Click the New button to open the Report Definition window. Make 
the following entries. 

 
Report Name Array Lesson
Series Sales
Main Table Customer Master Summary 
Using Key RM_Customer_MSTR_SUM_Key1
Maximum Records 0
Format Options Text Report
Text Report Options 17 Characters/Inch 
Printing Options First Page Header 
Printing Options Last Page Footer 

 
4. Click the Layout button to open the report layout area. Complete the 

layout of the report by referring to the following illustration and 
steps for guidance. 

5. Add a title to the report header called Customer Summary Overview. 

6. Make the body of the report larger by clicking on the "B" in the 
vertical gray bar on the left side of the window and dragging it down. 
Increase the size from 48 pixels to 120. 

7. Place the Customer Number field into the body section of the 
report, and add an appropriate text prompt to the left of that field. 

8. The report layout also includes the aging period amounts for each 
customer. Those amounts are stored in an array field called Aging 
Period Amounts. Because Customer can have up to seven aging 
periods and it is not known exactly how many have been assigned, 
all seven will be added to the report layout. They will be arranged in 
one column within the body of the report.  
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9. Add the Aging Period Amounts field by holding down the CTRL 
key, selecting Aging Period Amounts from the Toolbox, and 
dragging the field into the body of the report below the Customer 
Number. All of the seven amounts will be added to the layout.  

10. Add text labels for each aging period. 

 

 
 

11. Close the layout window, and select to save your changes. Click OK 
in the Report Definition window to save the report. 

12. In the Report Writer window, highlight the Array Lesson report in 
the Modified Reports list and click Print.  

13. The screen output window should appear similar to the following: 
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Lab 5.2 − Field Options 
Company: Fabrikam, Inc. 

 
Scenario: To better handle incoming phone calls and ultimately provide better 
customer service, it has been decided that you need a report that displays all of 
your customers and the salesperson that has been assigned to each customer. For 
added reference, make sure the report counts the number of customers that each 
salesperson has been assigned. Also, add a field that counts the total number of 
salespeople listed on the report. 

Solution 
 

1. Open the Report Writer main menu. (TOOLS→CUSTOMIZE→REPORT 
WRITER) 

2. Click the Reports button to open the Report Writer window where 
all original and modified reports are listed. 

3. Click the New button and make the following entries. 

 
Report Name Salesperson - Field Options 
Series Sales
Main Table RM Salesperson Master 
Using Key RM_Salesperson_MSTR_Key1 
Maximum Records 0
Format Options Skip Blank Records 
Printing Options First Page Header, Last Page Footer

 
4. To include all your fields on the report, the RM Customer Master 

table needs to be linked to the report. This can be done by selecting 
the Tables button. On the Report Table Relationships window, select 
New to open the Related Tables window.  

5. Highlight the RM Customer Master table and select OK. Close the 
Report Table Relationships window. 

6. Select Layout to open the Report Layout window.  

7. From the Tools menu, select Section Options. (TOOLS→SECTION 
OPTIONS) Ensure the Report Header, Body, and Report Footer 
sections are selected on the Report Section Options window.  

8. Ensure the Page Header and Page Footer selections are selected.  

9. Create an additional header. This header will be printed at the 
beginning of each new group, which is each time a new salesperson's 
information is printed. To create the additional header, click the New 
button at the right of the Additional Headers list.  
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10. In the Header Options window, make the following selections, and 
click OK to close the window. 

 
Header Name Salesperson ID 
Print When Field Changes:
  Report Table RM Salesperson Master 
  Field Salesperson ID 

 
11. Repeat the process to create an additional footer. This footer prints 

information about the group above it. It prints how many customers 
are assigned to a salesperson. To create another footer, click the New 
button at the right of the Additional Footers list.  

12. In the Footer Options window, make the following selections. 

 
Footer Name Customer Count 
Print When Field Changes:
  Report Table RM Salesperson Master 
  Field Salesperson ID 

 
13. Click OK to close the Footer Options window; then click OK to 

close the Report Section Options window. 

14. The modifications you make to the report should resemble the 
following illustration when it is complete. 

 

 

 
15. From the RM Salesperson Master table, place the Salesperson ID 

field in the additional header section of the report (labeled H1) and 
again in the report footer (labeled RF).  

16. From the RM Customer Master table, place the Customer Number 
field in the body of the report (labeled B) and in the additional footer 
(F1). Position and resize the fields. 
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17. Use the text tool from the Toolbox to create labels for the fields you 
have added. Place them in the layout window according to the 
illustration shown earlier in this exercise. 

 1st Salesperson ID field   Salesperson ID: 

 2nd Salesperson ID field  Total Salespeople: 

 1st Customer Number field Customers: 

 2nd Customer Number field Total Number of Customers 
for this Salesperson: 

18. Select the Customer Number field you placed in the additional 
footer. From the Tools menu, select Field Options. Set the Field 
Type to Count in the Report Field Options window, and click OK to 
close the window. 

19. Select the Salesperson ID field you placed in the report footer. From 
the Tools menu, select Field Options or double-click on the field. Set 
the Field Type to Control Count in the Report Field Options 
window, and click OK to close the window. 

20. Close the Report Layout window, and save the changes. Click OK in 
the Report Definition window to save the report. 

21. In the Report Writer window, highlight the report for Field Options 
Lesson in the list of Modified Reports and click Print.  

22. Select to send the output to the screen. The screen output should look 
similar to the following: 
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Lab 5.3 − Calculated Fields 
Company: Fabrikam, Inc. 

 
Background Information: The concatenate (CAT) operator joins two elements 
of an expression together, and the STRIP function removes trailing blank spaces 
from string fields.  
 
Scenario: Your experience has shown you that some tables in Microsoft 
Dynamics GP store the City, State, and Zip Code fields as separate fields. 
Today you are going to create a report that lists all the locations for your 
company. To make the report look a little neater, create a calculated field that 
concatenates, or joins, the City, State, and ZIP Code fields. Use the CAT 
operator and the STRIP function to create the field. 

Solution 
 

1. Select Report Writer from the Customize option on Tools menu. The 
Report Writer main menu appears. (TOOLS→CUSTOMIZE→ REPORT 
WRITER) 

2. Click the Reports button to open the Report Writer window where 
all original and modified reports are listed. 

3. Click the New button and make the following entries. 

 
Name Concatenated Fields Exercise 
Series Company
Main Table Company Location Master 
Using Key SY_Location_MSTR_Key1 
Format Options Text Report

 
4. Click Layout to open the Report Layout window. 

5. From the drop-down list within the Toolbox, select Calculated fields, 
and click the New button at the bottom of the window. The 
Calculated field Definition window appears.  

6. Make the following entries. Refer to the illustration shown later in 
this exercise. 

 
Name City State ZIP
Result Type String
Expression Type Calculated
Functions Tab
  Type: System-defined
  Function: STRIP
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7. Click the Add button.  

 
Fields Tab
  Resources: Company Location Master 
  Field: City

 
8. Click the Add button.  

9. In the Calculated Expression field, click to the right of the closing 
parenthesis. 

 
Operators CAT
Constants Tab
  Type: String
..Constant: Press the spacebar twice 

 
10. Click the Add button.  

 
Operators CAT
Functions Tab
  Type: System-defined
..Function: STRIP

 
11. Click the Add button.  

 
Fields Tab
  Resources: Company Location Master 
  Field: State

 
12. Click the Add button.  

13. In the Calculated Expression field, click to the right of the closing 
parenthesis. 

 
Operators CAT
Constants Tab
  Type: String
..Constant: Press the spacebar twice 

 
14. Click the Add button.  

 
Operators CAT
Fields Tab
  Resources: Company Location Master 
..Field: Zip Code
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15. Click the Add button.  

 This completes the expression. You can correct the expression by 
removing or adding a token if necessary. The most common mistake 
made when concatenating is clicking to the right of the parenthesis. 
If you are having difficulties with the field, remove it and start again, 
following the instructions precisely. 

16. When you have written the expression, the window should look like 
the following window illustration. Once you have verified that you 
have entered the information correctly, click OK to save the 
expression and close the window. 

 

 
 

17. Position the following fields from the Company Location Master file 
in the body of the report. Refer to the illustration of the report shown 
later in this exercise for guidance. (Size the fields accordingly.) 

 Location Name  Address1 

 Address 2   City 

 State   Zip Code 

 
NOTE: The City, State, and Zip Code are added to the layout even though a calculated 
field was already created to represent those fields. The individual fields are added to the 
layout so that they can be used later in the exercise to resize the calculated field. 
 

18. Highlight the new calculated field in the list of calculated fields in 
the Toolbox, and place it in the body of the report under the City, 
State, and Zip Code fields that were added previously. Resize the 
field so it is the same width as the three individual fields combined. 
This step is necessary so that if the maximum length for each of the 
fields is needed, the information is still printed properly.  
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Refer to the following illustration for guidance. 

 

 
 

19. Remove the individual City, State, and Zip Code fields. Reposition 
the calculated field, City State ZIP field, just below the address 
fields. Refer to the following illustration for guidance. 

 

 
 

20. Close the Report Layout window, and save the changes. Click OK in 
the Report Definition window to save the report.  
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21. Highlight the report for the Concatenated Fields Lesson in the list of 
Modified Reports and click Print. Send the output to the screen.  

 The screen output window should look like the following illustration: 
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Lab 6.1 − Report Planning 
 

1. Which Microsoft Dynamics GP module will this report be used 
with? 

 Receivables Management 

2. List the significant words and phrases in the above paragraph. 

 All salespeople, For each salesperson…list of…customers, for 
each customer…total purchases…past 90 days. 

3. List the nouns within these significant words and phrases. 

 Salespeople, customers, purchases, days 

4. Translate these nouns into prospective fields. 

 Salesperson ID, Salesperson Name, Customer Number, 
Customer Name, Aging Amounts. 

5. Where can you find the sample reports for most modules? 

 Find them under the Help Menu in the Microsoft Dynamics GP 
application. 

6. Use Field Descriptions to locate the table where the Salesperson ID 
and Customer Name fields are stored. List the possible tables. 

 The Salesperson ID field is stored in the following tables: the 
header and detail work and history tables for all of the sales 
series modules, Commission History, Customer Master Address 
File, commission-related tables, RM Customer MSTR, RM Open 
File, RM Salesperson Master, RM_Class_MSTR, Sales Territory 
Master File, Salesperson Master Summary File, and some 
temporary tables. 

 The Customer Name field is stored in the following tables: the 
header work and history tables for all of the sales series modules, 
RM Customer MSTR, RM Finance Charge Register, RM Period 
Sales Analysis Header, RM PTR BFC Register, Sales Deposit 
History, Sales Prospect Master, and some temporary tables. 

 Use Window Descriptions to locate the table where the aging 
amounts for each customer are stored. List the possible tables. 

 RM_Customer_MSTR, RM_Customer_MSTR_SUM, 
RM_Module_SETP, and RM_Period_SETP. 
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7. Use Table Descriptions to locate the field within the table you 
identified above that stores the aging amounts. What is the name of 
this field? 

 Aging Period Amounts 

8. Based on the information you found above, identify the tables you 
will use in this report, and within each, the main fields you will be 
using. 

 RM Salesperson Master: Salesperson ID, Salesperson First 
Name, Salesperson Last Name; RM Customer MSTR: Customer 
Name; and Customer Master Summary: Aging Period Amounts. 

9. List the main table for the report. 

 RM Salesperson Master 

10. What tables will you link to the main table? 

 Using the daisy chain method, link RM Customer MSTR to RM 
Salesperson MSTR and Customer Master Summary to RM 
Customer MSTR. 

11. Identify any additional headers and footers you will need in the 
report. 

 You need one additional header to hold salesperson-related fields 
and an additional footer to hold customer totals. 

12. How will the fields on the report be sorted? 

 The salespeople will be sorted alphabetically in ascending order. 
The customers will be sorted alphabetically in descending order. 
The aging periods will be listed in ascending order. 

13. How will the report be restricted? 

 Only customers that have an aging balance greater than $0.00 
will be printed. 

14. List the totals you need to see on the report. 

 Total number of customers per salesperson, aging period 
amounts total for each customer, aging period amounts grand 
total, and total number of salespeople. 

15. List the totals that will need to be created within Report Writer. 

 Total number of customers per salesperson, aging period 
amounts total for each customer, aging period amounts grand 
total, and total number of salespeople. 
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Lab 7.1 − Define and Use a New Table Relationship 
Company: Fabrikam, Inc. 

 
Background Information: In a previous lesson, you created both a primary and 
a secondary copy of the Blank Invoice Form. In this exercise, you create a table 
relationship that you use with the primary copy of the Blank Invoice Form. The 
goals of this exercise are to learn how to create a table relationship and to learn 
how to use the newly created table relationship in a report. 
 
Scenario: You have learned that important information is being entered in the 
Item Level Notes window for Invoices. This information is important to 
customers as well so you decide to include the notes on your Invoices. Since the 
notes do not reside in a table that is currently linked to the Invoice, you need to 
create a relationship between the Item Master table and the Record Notes Master 
table. The Record Notes Master table then needs to be linked to the Blank 
Invoice Form so that notes attached to inventory items can be printed on the 
report. 

Solution 
Creating the Relationship  
 

1. Select Report Writer from the Customize option on the Tools menu. 
The Report Writer main menu appears. (TOOLS→CUSTOMIZE→ 
REPORT WRITER) 

2. Click the Tables button on the toolbar to open the Tables window. 
Select the primary table, which for this exercise is IV_Item_MSTR 
and click the Open button to open the Table Definition window. 

– Which of the three table names (display, technical, or physical) 
is used in the Table window? Technical 

 
HINT:  Use the Tables Descriptions window (FILE→TABLE DESCRIPTIONS) to find the 
answer to this question. 

 
– In which window can you find all three of these names together 

in one place? Table Names 
 
HINT: Click the ellipsis button in the Table Description window. 

 
– How do you access this window from Microsoft Dynamics GP 

and not Report Writer?  
TOOLS→RESOURCE DESCRIPTIONS→TABLES 
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3. Click the Relationships button to open the Table Relationship 
window. Verify that the relationship you want to create does not 
already exist. Specifically, verify that Record Notes Master is not 
currently in the Table Relationships list. 

– Is it possible to delete a relationship that was created as part of 
the original Microsoft Dynamics GP dictionary? No 

 
4. Click the New button to open the Table Relationship Definition 

window. Make the following entries. Refer to the illustration that is 
given for guidance. 

 Secondary Table:  Record Notes Master 

 Secondary Table Key: SY_Record_Notes_MSTR_Key_1  

 
 Match the Note Index field in the Record Notes Master table with 

the Note Index field in the Item Master table by selecting Note 
Index from the drop-down list for the Primary Table. 

 

 

 
NOTE: Keep in mind that when creating valid relationships, it is not the field names that 
have to be exact; it is the contents of the fields. 
 
For example: the Originating Master Name field in the Year-to-Date Transaction Open 
table corresponds to the Vendor Name field in Payables Management and the Customer 
Name field in Receivables Management. 
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– Is this relationship one-to-one or one-to-many?  
Yes 

 
– What is a one-to-one relationship?  

One record in the primary table matches one record in the 
secondary table. 

 
– What is a one-to-many relationship?  

One record in the primary table matches multiple records in 
the secondary table. 

 
– What are the advantages of creating a one-to-one relationship? 

More capabilities when linking additional files if 
relationships are one-to-one. 

 
– What do the fields listed in the Primary Table drop-down list 

have in common with the corresponding key segment (field) in 
the Secondary Table portion of the Relationship scrolling 
window?  
They have the same data type. 

 
5. Click OK to close the Table Relationship Definition window and to 

save your new relation. 

6. Verify that the secondary table now exists in the Table Relationships 
list on the Table Relationship window. 

– Can you delete a relationship you created yourself?  
Yes 

 
7. Close the Table Relationship window. Click OK to close the Table 

Definition window. Close the Tables window. You are now ready to 
use the new relationship in a report. 

Linking the Record Notes Master Table to the Report  
 

1. Click the Reports button to open the Report Writer window where 
all original and modified reports are listed. 

2. In the Report Writer window, highlight the Blank Invoice Form in 
the list of Modified Reports, and click the Open button to open the 
Report Definition window. 

3. Click the Tables button to open the Report Table Relationships 
window. 
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4. Highlight the Item Master table in the Report Table Relations list and 
click the New button to open the Related Tables window. Select 
Record Notes Master and click OK.  

 

 
 

5. Click Close to save your selections and click the Layout button to 
open the Report Layout window. 

6. Increase the size of H2 by one line. Select Record Notes Master from 
the drop-down list in the Toolbox window. Drag the Text Field onto 
the layout and place it below the Item Number field in H2. Resize 
the field as shown in the following illustration: 
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Printing the Report 
 

1. Close the Report Layout window, and save your changes. Switch to 
the Microsoft Dynamics GP application (FILE→ MICROSOFT DYNAMICS 
GP) and open the Invoice Entry window. To do this, click the 
Transactions button and select Sales, and select Invoice Entry. 
(TRANSACTIONS→SALES→INVOICE ENTRY) 

2. Click one of the browse buttons in the Invoice Entry window to 
bring up one of the existing documents.  

3. Add a note to one of the items. To do this with your mouse, click one 
of the items listed on the invoice. Then click the Note button next to 
the Item Number prompt. Enter some text into the Note window. 
Click Attach to attach the note to the item and close the window. 

4. Select Document Format from the Options menu to open the Invoice 
Document Formats window. Set the Invoice Format to Blank Paper. 
Click OK to close the window. 

5. Click the Print button. In the Report Destination window, choose to 
send the output to the screen. The report should look similar to the 
following: 

 

 

 
6. Verify that the invoice where the Item Note was added printed on the 

invoice successfully. (No note entered on sample) 
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Lab 8.1 − Formats and Data Types 
Company: Fabrikam, Inc. 

 
Scenario: It has come to your attention that none of the phone numbers in your 
Microsoft Dynamics GP system have the extension part of the phone number 
filled in. However, all of your reports are currently showing Ext. 0000 as part of 
the phone number. Use Report Writer to change the format that the phone 
number data type uses.  

Solution 
 

1. Select Report Writer. (TOOLS→CUSTOMIZE→REPORT WRITER) 

2. Select Formats from the Resources menu; the Formats window 
appears. (RESOURCES→FORMATS) 

3. Select the Phone_Number format and select Open. The Format 
Definition window appears like the following illustration. 

 

 
 

4. In this window, change the Phone_Number format used by this data 
type to remove the "Ext." abbreviation and the four characters in the 
format that represent the extension. To do this, use the following: 

 Format Strings: Highlight the existing format string and click 
Remove. 

 Format String: Delete "Ext. XXXX" from the format string and 
click Insert. 
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5. Since you use only numbers in your phone number fields, set the 
format so it accepts only numbers: 

 String Options: Select the Numeric Only check box. 

6. The Format Definition window should look like the following: 

 

 
  

7. To save the changes to the phone number data type and its format, 
click OK to close the Format Definition window.  

8. When finished, print the Company Addresses Report to the screen 
using Report Writer. All phone numbers that use the Phone_Number 
format definition should display in the new format. 

 
Old Format New Format 
(312) 555-2449 Ext. 0000 (312) 555-2499 
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Lab 8.2 − Modify Drop-down List 
Company: Fabrikam, Inc. 

 
Scenario: You want to change the name of the financial series to General 
Ledger. Once you have changed the field's static text value, the field displays 
"General Ledger" instead of "Financial" on all the reports where the field 
appears. This change takes place on all reports, including original reports. 

Solution 
 

1. Open Report Writer. (TOOLS→CUSTOMIZE→REPORT WRITER) 

2. Click the Fields button to open the Fields window.  

3. Highlight the Series field, and select Open to open the Field 
Definition window.  

4. Select Open again to open the Data Type Definition window.  

5. Select the Static Text Values lookup button to open the Static Text 
Values window. 

6. Select Financial in the Static Text Value list, then highlight 
"Financial" in the New Value field and enter "General Ledger."  

The window should look like the following illustration. 
 

 
 

7. Click the Replace button to replace the text value "Financial" with 
"General Ledger." Click OK in the Text Static Values, Data Type 
Definition, and Field Definition windows to save your changes and 
close the windows. 
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8. The change takes place on all reports, including original reports. To 
view the change that you have made, go to Microsoft Dynamics GP 
application (FILE→MICROSOFT DYNAMICS GP), and print the Posting 
Accounts Report. (REPORTS→COMPANY→SETUP)  

9.  Select the Posting Accounts report. Insert the demo option and print 
the report to the window.  

 The output window should look similar to the following illustration: 

 

 

Lab 8.3 − Modify Strings 
Company: Fabrikam, Inc. 

 
Scenario: In this exercise, you change all occurrences of the text prompt "City:" 
to "Town:" 

Solution 
 

1. Select Report Writer from the Customize option on the Tools menu. 
The Report Writer main menu appears. (TOOLS→CUSTOMIZE→ 
REPORT WRITER) 

2. Select Strings from the Resources menu. The Strings window 
appears. (RESOURCES→STRINGS) 

3. Select the System series. 

 
HINT: Because of the numerous text strings included in the Microsoft Dynamics GP 
dictionary file (dynamics.dic), once a string has been selected, it may take a few 
moments for the Strings window to open. 

 
4. Locate City: in the list of strings and select it. 
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5. Select Open and when the String Definition window appears, replace 
City: with Town: 

 When you have finished, the window should resemble the following 
illustration. 

 

 
 

6. Select OK in the String Definition window, and close the Strings 
window.  

7. The change takes place on all reports, including original reports. To 
view the change you have made, return to the Microsoft Dynamics 
GP application (FILE→MICROSOFT DYNAMICS GP), and print the 
Company Addresses Report to verify the changes. 
(REPORTS→COMPANY→SETUP→ADDRESSES)  

 The output window should look similar to the following illustration: 
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Lab 8.4 − Per Record Format, Decimal Places 
Company: Fabrikam, Inc. 

 
Scenario: Create a custom inventory report that displays the item number, item 
description, and the quantity on hand for that item. The report will also total the 
number of items listed in the report. In order to accommodate a field that can 
store a different number of decimal places, depending on the value stored in a 
related field, you need to create a per-record format for use with that field. 
Specifically, create a per-record format to use with the QTY on Hand field. 

Solution 
Creating the Report 
 

1. Open Report Writer. (TOOLS→CUSTOMIZE→REPORT WRITER) 

2. Click the Reports button to open the Report Writer window where 
all original and modified reports are listed. 

3. Click the New button to open the Report Definition window. Make 
the following entries. 

 
Report Name Inventory Items Report 
Series Inventory 
Main Table Item Master 
Using Key IV_Item_MSTR_Key1 
Max Records 20 
Format Options Text Report 
Text Report Options 17 Characters/Inch, Six Lines/Inch 
Printing Options none 

 
4. Click the Tables button from the Report Definition window to open 

the Report Table Relationships window. Add the Item Quantity 
Master table to the report by clicking the New button, highlighting 
the Item Quantity Master table, and clicking OK. 

5. Click the Close button to return to the Report Definition window. 

6. Click the Layout button to open the Report Layout window. 

7. Use the text tool to add the following text fields to the Page Header 
section (PH). 

– Item Number 
– Description 
– Qty on Hand 
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8. Use the text tool to add the following text fields to the Report Header 
section (RH). 

– Inventory Items on Hand 
– Item Number 
– Description 
– Qty on Hand 

 
9. Add the following fields to the Body section (B) by clicking and 

dragging from the toolbox. 

– Item Master  Item Number 
– Item Master  Description 
– Item Quantity Master Qty on Hand 

 
10. Add the following field and label to the Report Footer section (RF) 

by clicking and dragging from the toolbox. 

– Field  Item Number 
– Label  Number of Items 

 
11. Double-click on the Item Number field in the Report Footer section, 

and change the Field Type to Count. 

12. Use the following illustration to adjust/align fields in the report 
layout: 

 

 
 
NOTE: All the fields in the body have a field type of Data. The Item Number field in RF 
should have a field type of Count. 
 

13. Double-click on the QTY on Hand field to open the Report Field 
Options window. In the Format Field section of the window, the first 
field in the section should display as Item Master.  
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14.  From the list of Fields below Item Master, select Decimal Places 
QTYS, as seen below, and click OK to close the window. 

 

 
 

15. Click OK to close the Report Field Options window. 

16. Close the Report Layout window and save your changes.  

17. Print the report in the Report Writer. The output window should look 
similar to the following illustration: 

 

 



Microsoft Official Training Materials for Microsoft Dynamics ™ 
Your use of this content is subject to your current services agreement 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  

Report Writer in Microsoft Dynamics GP 9.0 

Page 410  

Lab 9.1 − Setting up a Report Schedule 
Company: Fabrikam, Inc. 

 
Scenario: Every Monday morning your boss likes to receive a copy of the most 
recent Receivables Management Historical Aged Trial Balance. Create a report 
schedule that will run this report automatically. This exercise assumes that 
general Report Scheduler setup has already been completed. 

Solution 
 

1. Navigate to the Receivables Trial Balance Reports window. 
(REPORTS→SALES→TRIAL BALANCE) 

2. Select Historical Aged Trial Balance from the Reports drop-down 
list. 

3. Create a new report option by clicking the New button and entering 
Weekly as the Option Name. 

4. Select Current Date as the Print/Age As of selection. 

 

 
 

5. Change the Destination for the report to File by clicking the 
Destination button and selecting the check box for File. Select the 
location of the file by clicking the folder for File Name and entering 
"Weekly Trial Balance" for the File Name. Select a File Format.  

6. Click OK to return to the Receivables Trial Balance Report Options 
window. 

7. Accept the defaults for information not provided. 
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8. Click the Save button, and close the window. 

9. Navigate to the Report Schedule window. 
(TOOLS→ROUTINES→COMPANY→REPORT SCHEDULE) 

10. Select a Frequency of Weekly from the drop-down list. 

11. Select the check box for Monday. 

12. Select the check box beside the Weekly Report Option for the Sales 
Historical Aged Trial Balance. 

 

 
 

13. Click the Publish now button to generate the report immediately. If 
you select the Apply button, the Frequency is established and you 
will be prompted, at login, with a message to publish the report at the 
scheduled time. 
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Lab 9.2 − Adding a Publisher 
Company: Fabrikam, Inc. 

 
Scenario: You are about to leave for vacation and need to assign your report 
publishing duties to another user during your absence. Assign your weekly 
Receivables Management Historical Aged Trial Balance to LESSONUSER2. 

Solution 
 

1. Navigate to the Report Publishers window. 
(TOOLS→ROUTINES→COMPANY→REPORT PUBLISHERS) 

2. Select LESSONUSER2 from the list of users by clicking the lookup 
button next to the User ID field. 

3. Select the Publish check box next to the Weekly Sales Historical 
Aged Trial Balance. 

 

 
 

4. Click the Save button. 
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Lab 9.3 − Deleting Report Catalog Information 
Company: Fabrikam, Inc. 

 
Scenario: You would like to start over with the Report Schedule for the 
Receivables Management Historical Aged Trial Balance. Before editing the 
Report Schedule, you know that you should remove the existing Report Catalog 
information.  

Solution 
 

1. Navigate to the Report Catalog Maintenance window. 
(TOOLS→ROUTINES→COMPANY→REPORT CATALOG MAINT.) 

2. Select the check box beside the Historical Aged Trial Balance report 
name.  

 

 
 

3. Click the Delete button. 
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Day One: Case Study 
Company: Fabrikam, Inc. 

 
Scenario: You have been asked to create a new report that lists all customer 
contacts for each of your company's salespeople. This report will be based on 
three Microsoft Dynamics GP tables and include different report sections for 
each table. When you complete the project, the first page of the report should 
look similar to the following illustration: 
 

 
 

Solution 
 

1. Select Report Writer from the Customize option on the Tools menu. 
The Report Writer main menu appears. (TOOLS→CUSTOMIZE→REPORT 
WRITER) 

2. Click the Reports button to open the Report Writer window where 
all original and modified reports are listed. 
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3. Click New, and the Report Definition window opens. Define the 
report using the following information: 

 
Report Name Salesperson Contact List 
Series Sales 
Main Table RM Salesperson Master 
Using Key RM_Salesperson_MSTR_Key1 

 
 Accept the defaults for the other fields. The Report Definition 

Window appears as follows: 

 

 
 

 To access customer information on the report, you need to add some 
customer tables to the report. 

4. To add these tables, click Tables to open the Table Relationships 
window.  

5. With RM Salesperson Master highlighted in the list of Report Table 
Relations, click the New button. Select RM Customer Master and 
click OK.  

6. Select RM Customer Master from the Report Table Relations list and 
click New. Select Customer Master Address File and click OK.  
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The Table Relationships window displays as follows: 

 

 
 

7. Click Close to close the Report Table Relationships window. 

8. You want to sort this report by salesperson and within each of the 
salesperson's information, sort the detail by customer. To do this, 
click Sort on the Report Definition window, and complete the 
following steps: 

– With the Report Table set to RM Salesperson Master, select 
Salesperson ID from the list of Table Fields.  

– Click Insert to add that field to the Sort By list.  
– Highlight the Salesperson ID field in the Sort By list so that any 

other sorts you add will be secondary to the initial sort. 
– Select RM Customer MSTR as the Report Table.  
– Select Customer Number from the list of Table Fields, and 

click Insert to add that field to the Sort By list.  
 

 
 

9. Click OK to close the Sorting Definition window. Next, define the 
layout of the report.  
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10. Select Layout on the Report Definition window to open the Window 
Layout screen. The first change to the layout of the report pertains to 
the report sections that default when the layout first opens. 

11. To change the sections of the report, click the Tools menu and select 
Section Options.  

 The report will include five different sections − a page header, a 
report header, two additional headers, and a body. The PH, RH, and 
B sections are included by default.  

12. Clear the Report Footer check box on the Report Section Options 
window to remove that section from the report.  

13. Select the New button next to the Additional Headers list to add a 
new section to the report.  

14. On the Header Options window enter Salesperson as the Header 
Name, and click on Salesperson ID as the field to break on.  

15. Click OK to save this new additional header.  

16. Again on the Report Section Options window, highlight the new 
additional header that was just added, and click the New button 
again.  

17. On the Header Options window that appears, enter Customer as the 
Header Name. Select RM Customer MSTR as the Report Table, and 
select Customer Number as the field to break on. 

18. Click OK to save the second additional header. After the new report 
sections have been defined, the Report Section Options window 
looks as follows: 
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19. Click OK to close the Report Section Options window and to show 
the new report sections on the Layout Window. 

20. Use the Date, Time, and Page Number tools to add the system date, 
system time, and a page number to the report layout. Place them in 
the PH section at the top of the report.  

21. Add a text prompt next to the Page number field.  

22. Resize the page header to remove the extra white space within the 
section.  

 When complete, the page header should look as follows: 

 

 
 

23. Resize the RH section of the report so that it is larger. It should be at 
least two inches high.  

24. Add a graphic to the report header by selecting the picture tool and 
clicking on the layout of the report. When the Pictures list appears, 
select Dynamics Logo and click OK. Center the picture in the 
middle of the RH section of the report.  

25. Use the Text tool to add a title to the report called Customer 
Contacts by Salesperson. Place this title below the graphic that was 
just added.  

26. To change the look of the title, select the text object, and then select 
Report Drawing Options from the Tools menu. Change the Font to 
Helvetica 24, and select Bold as the Font Style.  

27. Click OK to save those changes.  

28. Once back on the report layout window, resize the text object so the 
entire contents of the title can be seen, and center it directly below 
the Dynamics logo. When complete, the report header should look as 
follows: 

 

 
 

29. Resize the H1 section of the report so it is about three grids larger.  
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30. Add the following text prompts and fields to this additional header. 
The fields are added from the RM Salesperson Master table. Once 
the objects have been added, change the drawing options for the text 
prompts so that they are bold and underlined.  

 
Text Prompts Fields 
Salesperson ID Salesperson ID 
First Name Salespersons First Name 
Last Name Salespersons Last Name 
Territory Sales Territory 
Customer Name  

 
 When complete the H1 section of the report looks as follows. 

 

 
 

31. Add the Customer Name field from the RM Customer MSTR table 
to the H2 section of the report.  

32. Add a text prompt called Contacts to the same section of the report. 
Once the prompt is added, change the drawing options for the text so 
that it is bold.  

 When complete, the second additional header looks as follows: 

 

 
 

33. Add the Contact Person, Address Code, and Phone 1 fields to the 
B section of the report from the Customer Master Address File.  

34. Resize the fields so that they fit next to each other within the body of 
the report. In addition, also resize that section of the report to remove 
extra white space.  

 When complete, the body looks as follows: 
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 When complete, the entire report layout looks as follows: 

 

 

 
35. Close the Layout Window, and save your changes.  

36. Click OK on the Report Definition window to save the report.  

 Print the report from the Report Writer. The report should look 
similar to the illustration shown at the beginning of project. 

37. To restrict the report to print information for only one particular 
salesperson, open the Report Definition window.  

38. Select Restrictions, and on the Report Restrictions window select 
New. 

39. Enter Salesperson ID as the Restriction Name.  

– From the Fields section of the window, select RM Salesperson 
Master as the Report Table, and choose Salesperson ID as the 
Table Fields.  

– Click the Add Field button to add the field to the Restriction 
Expression. 

– In the Operators section, click on the = button. 
– In the Constants section, select String as the type and enter ERIN 

J. as the Constant.  
– Click the Add Constant button to add the constant to the 

Restriction Expression.  
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 When complete, the Report Restriction Definition window looks as 
follows: 

 

 
 

40. Click OK to save the new restriction, and close the Report 
Restrictions window.  

41. Click OK to close the Report Definition window.  

42. Print the report from the Report Writer.  
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Planning a Report: Case Study 
Company: Fabrikam, Inc. 

 
Estimated Time: 40 Minutes 
 
Scenario: Plan and design the report by determining the tables and fields needed, 
sorting options, additional sorting methods and additional restrictions, and the 
report layout desired. 

Solution 
Your finished report should look similar to the following illustration: 
 

 
 

1. Select Report Writer from the Customize option on the Tools menu. 
The Report Writer main menu appears. (TOOLS→CUSTOMIZE→REPORT 
WRITER) 

2. Click the Reports button to open the Report Writer window where 
all original and modified reports are listed. 

3. Click New, and the Report Definition window opens.  
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4. Define the report using the following information: 

 
Report Name Salesperson Report 
Series Sales
Main Table RM Salesperson Master 
Using Key RM_Salesperson _MSTR_Key1
First Page Header Uncheck

 
 Accept the defaults for information not provided. 

 

 
 

5. Click the Tables button from the Report Definition window to open 
the Report Table Relationships window. Link the tables using the 
daisy chain method. The tables to link are as follows:  

– RM SALESPERSON MASTER→RM CUSTOMER MSTR 
– RM CUSTOMER MSTR→CUSTOMER MASTER SUMMARY 

 
HINT: Highlight the table you want to link from, and then click the New button to view 
choice of tables to be linked. 
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 When you finish linking tables, the Report Table Relationship 
window should look as follows: 

 

 
 

6. Click the Close button to return to the Report Definition window. 

7. Click the Sort button to open the Sorting Definition window.  

8. Highlight the Salesperson ID from the RM Salesperson Master table, 
and click the Insert button to establish the Primary Sort.  

9. Highlight the Customer Name from the RM Customer MSTR table, 
and click the Insert button to establish the Secondary Sort. Highlight 
the Customer Name sort by selection, sort by descending order, and 
choose to ignore case. The Sorting Definition window appears as 
follows: 

 

 
 

10. Click the OK button to return to the Report Definition window. 

11. Click the Layout button to open the Report Layout window. 
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12. Open the Report Section Options window (TOOLS→SECTION 
OPTIONS). 

13. Create the Additional Header with the following information:  

 Header Name  Salesperson  

 Field to break on Salesperson ID  

 

 
 

14. Create the Additional Footer with the following information: 

 Footer Name  Salesperson Total 

 Field to break on Salesperson ID  

 
NOTE: Add a page break to cause a separate page to print for each salesperson. 
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The Report Section Options window should look like the following 
illustration after you have created the additional header and 
additional footer. 

 

 
 

15. Add the System Date field to the upper left corner of the Report 
Header and the Page Header sections. Click the Date tool and then 
click the report layout where you want the date to appear. 

16. Use the Picture tool to add the old Dynamics Logo graphic to the 
Report Header. Center the Logo across the section. 

a. Click the Picture tool. 
b. Click in the approximate area of the Report Header where you 

want the logo to be. 
c. Select Dynamics Logo from the List and click OK. 
d. Resize and reposition the Logo as you want. 

 
17. Use the text tool to add the name of the report, "Salesperson Report" 

to the Report Header and the Page Header sections. Center the text 
across the section. Use the Drawing Options window 
(TOOLS→DRAWING OPTIONS) to make the title Bold, Italic, and 
Underlined with a font of Helvetica 24. 
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18. Add the following text prompts and fields to the Salesperson Header. 
(H1) Make the headings bold and underlined using the Drawing 
Options window. (TOOLS→DRAWING OPTIONS) 

 
Text Prompts Fields 
Salesperson ID Salesperson ID from the RM Salesperson 

Master 
First Name Salesperson First Name from the RM 

Salesperson Master 
Last Name Salesperson Last Name from the RM 

Salesperson Master 
Customer Name  
Aging Periods  

 
19. In the Body section of the report, add the Aging Periods as Array 

Fields. Also include the Customer Name field from the RM 
Customer MSTR table.  

 
HINT: Use the CTRL button while placing the Aging Periods field on the report to add 
them all at once, and then remove any fields you do not want. 

 
20. Use the column tool so that it automatically prints these fields again 

on the right side of the page. 

21. Create the Aging Periods Total-Body calculated field for totaling 
the aging periods.  

– Select Calculated Fields from the drop-down list in the Toolbox 
and click New. 

– Enter Aging Periods Total-Body as the Name. 
– Select Currency as the Result Type. 
– Accept Calculated as the Expression Type. 
– From the Fields tab, select Customer Master Summary as the 

Resource. 
– Select Aging Period Amounts as the Field. 
– Click the Add button. 
– Enter 1 as the Array Number and click OK. 
– Click the + Operator 
– Click the Add button. 
– Enter 2 as the Array Number and click OK. 
– Click the + Operator 
– Click the Add button. 
– Enter 3 as the Array Number and click OK. 
– Click OK to Save the Calculated Field. 
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The following expression results: 

 EXPRESSION = RM_Customer_MSTR_SUM.Aging Period 
Amounts [1] + RM_Customer_MSTR_SUM.Aging Period Amounts 
[2] + RM_Customer_MSTR_SUM.Aging Period Amounts [3] 

 

 
 

22. Add this field to the body of the report under the existing Aging 
Period Amounts. 

23. Create the Aging Period Total-Footer 1 calculated field, and place 
it in the additional footer section. 

– Select Calculated Fields from the drop-down list in the Toolbox 
and click New. 

– Enter Aging Period Total-Footer 1 as the Name. 
– Select Currency as the Result Type. 
– Accept Calculated as the Expression Type. 
– From the Fields tab, select Calculated Fields as the Resource. 
– Select Aging Periods Total-Body as the Field. 
– Click the Add button. 
– Click OK to Save the Calculated Field. 

 
24. In the additional footer section of the report, add the following fields: 

– Salesperson ID from the RM Salesperson Master 
– Customer Name from the RM Customer MSTR  

 
25. Add text prompts to the Salesperson Footer (F1) as needed to 

complete the following sentence: 

 Salesperson ID has Customer Name customers with a total balance 
of Aging Period Total-Footer 1. 
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26. Use the Report Field Options window by double-clicking on the 
following fields to change their field types. 

– Change Customer Name to Count  
– Change Aging Periods Total-Footer 1 to Sum 

 
27. Attach a format to the Aging Period Total-Footer 1 field by 

opening the Report Field Options window for the field. To do this, 
double-click the field. Click the lookup button next to the Format 
field. Select the Dollar11 format from the Format Lookup scrolling 
window and click OK. Click OK to close the Report Field Options 
window. 

 
HINT: Formats determine how a field should display on a report. Formats can be 
assigned globally for a field, or they can be set individually on each report. The 
Dollar11 format that is selected in this exercise is a format that has been defined in 
Microsoft Dynamics GP for an amount field. It has options set so that a thousands 
separator will be used when the value of this field is displayed along with a currency 
symbol. More information about formats will be provided in the chapter called Data 
Types, Formats, and Strings. 

 

 
 

28. In the Report Footer, add the Salesperson ID field from the RM 
Salesperson Master and a text prompt to complete the following 
sentence. Change the field type for Salesperson ID to Count. Total 
number of salespeople: Salesperson ID. 
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The Report Layout looks like the following illustration when 
finished. 

 

 
 

29. Close the layout of the report, and save your changes. 

30. Set restrictions for the report, so it will print only the customers with 
the total balance of Aging Periods 1, 2, and 3 that are greater than 0.  

 This can be done using fields from the Customer Master Summary 
table. 

– Click the Restrictions button from the Report Definition 
window and click New. 

– Enter Aging Balance >0 as the Name. 
– From the Fields section, select Customer Master Summary as the 

Resource. 
– Select Aging Period Amounts as the Field. 
– Click the Add button. 
– Enter 1 as the Array Number and click OK. 
– Click the + Operator. 
– Click the Add button. 
– Enter 2 as the Array Number and click OK. 
– Click the + Operator. 
– Click the Add button. 
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– Enter 3 as the Array Number and click OK. 
– Click the > Operator. 
– From the Constants section, select Currency from the drop- 

down list for Type. 
– Click the Add button. 
– Click OK to Save the Restriction. 

 
The following expression results: 

 
 EXPRESSION = RM_Customer_MSTR_SUM. Aging Period 

Amounts [1] + RM_Customer_MSTR.SUM Aging Periods Amounts 
[2] + RM_Customer_MSTR._SUM Aging Period Amounts [3] > 
0.00000 

 

 
 

31. Print the report from Report Writer. Refer to the opening graphic and 
compare your report to it. Make any necessary changes.  
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Day Two: Case Study 
Company: Fabrikam, Inc. 

 
Estimated Time: 40 Minutes 
 
Scenario: The year-end is approaching, and you want to analyze inventory items. 
You want to see item and item quantity information for each vendor. To gather 
this information, the report will be based on multiple Microsoft Dynamics GP 
tables. When completed, the first page of the report will look like the following 
illustration: 

Solution 
 

 
 

1. Select Report Writer from the Customize option on the Tools menu. 
The Report Writer main menu appears. (TOOLS→CUSTOMIZE→ 
REPORT WRITER) 

2. Click the Reports button to open the Report Writer window where 
all original and modified reports are listed. 

3. Click New, and the Report Definition window opens.  
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4. Define the report using the following information: 

 
Report Name Vendor Inventory Report 
Series Purchasing 
Main Table PM Vendor Master File 
Using Key PM_Vendor_MSTR_Key1 

 
 Accept the defaults for the other fields on the Report Definition 

window. The Report Definition Window then appears as follows: 

 

 
 

5. To access each vendor's account number on the report, you need to 
create a new relationship between two tables. To create this 
relationship, click the Tables button on the Report Writer toolbar.  

a. Select Tables from the menu. 
b. Select PM_Vendor_MSTR from the list of tables.  
c. Select Open to open the Table Definition window.  
d. Click the Relationships button and select New. 
e. On the Table Relationship Definition window, click on the 

lookup button next to the Secondary table field.  
f. Select Account Index Master and click OK.  
g. Select GL_Account_Index_MSTR_Key1 as the Secondary Table 

Key.  
h. From the Primary Table link the PM Purchases Index to the 

Account Index field in the Secondary Table.  
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6. Click OK to save the new table relationship, and close the Table 
Relationships window. 

 In order to access each vendor's item information on the report, you 
need to create another new relationship from the PM_Vendor_MSTR 
table.  

7. To create this relationship, again click the Relationships button and 
select New. 

a. On the Table Relationship Definition window, click the lookup 
button next to the Secondary table field.  

b. Select Item Vendor Master and click OK.  
c. Select IV_Item_MSTR_VNDR_Key2 as the Secondary Table 

Key.  
d. From the Primary Table, link the Vendor ID to the Vendor ID 

field in the Secondary Table.  
 

 When complete, the Table Relationship Definition window appears 
as follows: 

 

 
 

8. Click OK to save the new table relationship and to close the Table 
Relationships window.  

9. Click OK to close the Table Definition window. 

 To add the account information to the report along with the item and 
quantity detail, you need to add some additional tables to the report.  
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10. From the Report Definition window, click the Tables button to open 
the Table Relationships window, and complete the following steps: 

a. With PM Vendor Master File highlighted in the list of Report 
Table Relations, click the New button.  

b. Select Account Index Master and click OK.  
c. With PM Vendor Master File still highlighted, again click New.  
d. Select Item Vendor Master and click OK.  
e. Highlight Item Vendor Master in the list of Report Table 

Relations, and click the New button.  
f. Select Item Master and select OK.  
g. Highlight Item Master in the list of Report Table Relations and 

click New.  
h. Select Item Quantity Master and select OK.  

 
 With all of the tables added to the report, the Report Table 

Relationships window looks as follows: 

 

 
 

11. Click the Close button to close the Report Table Relationships 
window. 

 You want this report to sort information by vendor, and within each 
of the vendor's information, to sort the detail by the item number.  

12. To do this click the Sort button on the Report Definition window 
and complete the following steps: 

a. With the Report Table set to PM Vendor Master File, select 
Vendor ID from the list of Table Fields.  

b. Click Insert to add that field to the Sort By list.  
c. Highlight the Vendor ID field in the Sort By list so that any 

other sorts you add will be secondary to the initial sort.  
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d. Select Item Vendor Master as the Report Table.  
e. Select Item Number from the list of Table Fields, and click 

Insert to add that field to the Sort By list.  
 

The Sorting Definition window now looks as follows: 

 

 
 

13. Click OK to close the Sorting Definition window. 

 Next define the layout of the report.  

14. Select Layout on the Report Definition window to open the Report 
Layout window.  

 The first change you make to the layout of the report pertains to the 
report sections that default when the layout first opens.  

15. To change the sections of the report, click the Tools menu and select 
Section Options. 

 The report will include six different sections − a page header, a 
report header, an additional header, a body, an additional footer, and 
report footer. The PH, RH, B, and RF sections will be included by 
default.  

16. Select the New button next to the Additional Headers list to add a 
new section to the report.  

a. On the Header Options window enter Vendor as the Header 
Name. 

b. Click the Vendor ID as the field to break on.  
c. Select OK to save this new additional header. 
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17. Click the New button next to the Additional Footers list to add a new 
footer section to the report. 

a. On the Footer Options window enter Vendor as the Footer 
Name. 

b. Click on the Vendor ID as the field to break on.  
c. Click OK to save this new additional footer. 

 
 After the new report sections have been defined, the Report Section 

Options window looks as follows: 

 

 
 

18. Click OK to close the Report Section Options window and to show 
the new report sections on the Layout Window. 

19. Use the Date, Time and Page Number tools to add the system date, 
system time, and a page number to the report layout. Place them in 
the PH section at the top of the report.  

20. Add a label next to the page number field.  

21. Resize the page header to remove the extra white space within the 
section. When complete, the page header should look as follows: 
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22. Resize the RH section of the report so that it is larger.  

23. Use the Text tool to add a title to the Report Header (RH) section of 
the report called Vendor Inventory Report.  

24. To change the look of the title, select the text object, and then select 
Drawing Options from the Tools menu. (TOOLS→DRAWING OPTIONS) 
Change the Font to Helvetica 24, and Bold as the Font Style. Also 
use the Drawing Options window to Center the title.  

25. Click OK to save those changes. Once back on the report layout 
window, resize the text object so the entire contents of the title can 
be seen, and center it within the section.  

 
HINT: This is easily accomplished if the title extends the entire width of the report. 

 
 When complete, the report header should look as follows: 

 

 
 

26. Resize the H1 section of the report so it is about two grids larger. 
Add the following text prompts and fields to this additional header.  

 
Text Prompts Fields 
Vendor ID: Vendor ID from the PM Vendor Master 

File 
Purchase Account: Account Number from the Account Index 

Master 
Vendor Item #  
Item #  
QTY Sold  
QTY on Order  
QTY Returned  

 
27. Once the objects have been added, change the drawing options 

(TOOLS→DRAWING OPTIONS) for the text prompts so that they are bold.  

 When complete, the H1 section of the report looks as follows. 
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28. Add the following item fields to the B section of the report from the 
tables that are given.  

 
Item Vendor Master Table Item Quantity Master Table 
Vendor Item Number QTY Sold 
Item Number QTY Returned 
 QTY on Order 

 
29. Resize the fields so that they fit below the headings that were added 

to the additional header. Resize that section of the report to remove 
extra white space.  

 When complete the body looks like the illustration that follows 
where the fields are included directly below the prompts in the H1 
section of the report. 

 

 
 

30. Resize the F1 section of the report two grids larger. Add the 
following text prompts and fields to the additional footer. Add the 
fields from the tables that are indicated. Add the three QTY fields to 
the report two times. Add fields once next to the Total Text prompt 
and once next to the Average Text prompt. 

 
Text Prompts Fields 
Total # of Items Vendor Item Number from Item Vendor 

Master Table 
Total QTY Sold from Item Quantity Master Table 

(twice) 
Average QTY Returned from Item Quantity Master 

Table (twice) 
 QTY on Order from Item Quantity Master 

Table (twice) 
 

31. Once the objects have been added, change the drawing options for 
the text prompts so that they are bold.  

32. Resize the fields so that they align with their corresponding fields in 
the body of the report.  

 
HINT: Use multi-select fields and use the Size tool on the Arrange tab of the Toolbox. 
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When complete, the F1 section of the report should look like the 
following illustration where the QTY fields are directly below the 
QTY fields in the body of the report. 

 

 
 

 Now that the appropriate fields have been added to the additional 
footer on the report, you can change the field options for those 
objects so that they display total information for the report.  

33. To change the field options, double-click on each field to open the 
Field Options window by double clicking on the field to be changed.  

34. Select the following information for each field in the F1 section of 
the report. To select the format use the lookup button next to the 
Format field. 

 
Field Field Type Format 
Vendor Item Number Control Count none 
QTY Sold (Total) Sum DLR_RBS0_UTR 
QTY Sold (Average) Average DLR_RBS0_UTR 
QTY Returned (Total) Sum DLR_RBS0_UTR 
QTY Returned (Average) Average DLR_RBS0_UTR 
QTY on Order (Total) Sum DLR_RBS0_UTR 
QTY on Order (Average) Average DLR_RBS0_UTR 

 
35. Resize the RF section of the report so that it is about six grids larger. 

Add the following text prompts and fields to the report footer. Add 
the fields from the tables that are indicated. Resize the fields 
appropriately once they have been added to layout.  

 
Text Prompts Fields 
Total # of Vendors Vendor ID from PM Vendor Master File 
Total # of Items Vendor Item Number from Item Vendor 

Master  
Average Items per 
Vendor 
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 The report footer then looks as follows. 

 

 
 

 Now that the appropriate fields have been added to the report footer 
on the report, you can change the field options for those objects so 
that they display specific total information for the report.  

36. To change the field options, double-click on each field to open the 
Field Options window.  

37. Select the following information for each field in the RF section of 
the report. To select the format, use the lookup button next to the 
Format field. 

 
Field Field Type Format 
Vendor ID         Count Left_Justify 
Vendor Item Number Count Left_Justify 

 
 To complete the RF section of the report, we need to create one 

calculated field to compute the average # of items per vendor.  

38. To create this field, select Calculated Fields from the drop-down list 
in the Toolbox, and then select the New button under the list of fields 
that are displayed. Create the calculation by completing the 
following steps: 

a. Enter Items per Vendor as the Name of the field. 
b. Select Currency as the Result Type.  
c. Accept Calculated as the Expression Type.  
d. With the Fields tab selected, choose Report Fields as the 

Resource. 
e. Select RF_FREQ Vendor Item Number as the Field. 
f. Click the Add button to add the field to the Calculated 

Expression. 
g. From the Operators section, click the * button to add the 

multiplication operator to the Calculated Expression. 
h. Click the Constants tab, select Currency as the Type. 
i. Enter 1.00000 as the Constant.  
j. Click the Add button to add the field to the Calculated 

Expression. 
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HINT: When Report Writer computes a calculated expression, an integer value 
multiplied or divided by another integer value will always calculate to an integer. This is 
regardless of the Result Type that has been assigned to the calculated field that contains 
the expression. Because of this functionality, it is necessary to include a currency value 
within the expression for this exercise. You choose to multiply the frequency of the 
Vendor Item Number by 1.00000 before it is divided by the frequency of the Vendor ID. 
This is because both frequencies are considered integer values, and in order to calculate 
a true currency result you need to include a currency value in the calculation. 

 
k. From the Operators section, click the / button to add the division 

operator to the Calculated Expression. 
l. Click the Fields tab; select Report Fields as the Resource. 
m. Select RF_FREQ Vendor ID as the Field.  
n. Click the Add button to add the field to the Calculated 

Expression. 
 

 When complete, the Calculated Field Definition window should look 
as follows: 

 

 
 

39. Click OK to save the new calculated field. 
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40. Add the new Calculated Field to the report layout beside the label 
"Average Items per Vendor." 

 When complete, the entire report layout looks as follows: 

 

 

 
41. Close the Layout Window, and save your changes.  

42. Click OK on the Report Definition window to save the report.  

43. Print the report from the Report Writer. The report should look 
similar to the illustration shown at the beginning of the project, but 
when you view the report footer, notice the amount that displays as 
the average number of items per vendor. It will appear like the 
following: 

 

 
 

 The amount appears incorrectly because of the Field Options that 
default for fields and are placed in a footer of a report. By default, 
they are assigned a field type called Last Occurrence meaning that 
this field will have the last value it had on the report. Since this 
calculation has never been on the report, the last occurrence of the 
field is not what you want to display. To correct the value, the field 
type assigned to this field must be changed.  
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44. To change the Field Options, open the Report Definition window, 
and click the Layout button.  

45. When the Window Layout opens, double-click on the Items per 
Vendor field in the RF section of the report.  

46. When the Report Field Options window displays, select the 
following information for each field in the RF section of the report. 
To select the format use the lookup button next to the Format field. 

 
Field Field Type Format 
Items per Vendor Data  DLR_RBS0_UTR 

 
47. Click OK to close the Report Field Options window. 

48. Close the Layout Window, and save your changes.  

49. Click OK on the Report Definition window to save the report.  

50. Print the report from the Report Writer. The report should now not 
only look similar to the illustration shown at the beginning of the 
project, but it should also include the correct calculations.  


